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Über die X4 BPMS

Digitalisierung braucht eine ganzheitliche Betrachtung, die sich in der einzusetzenden Lösung 
widerspiegeln muss. Als zentrale Plattform unterstützt Sie die X4 BPMS dabei, diese 
Herausforderungen zu lösen. Im Fokus stehen dabei die Modellierung, Implementierung und 
Überwachung Ihrer Geschäftsprozesse. Daher enthält die X4 BPMS alle benötigten Werkzeuge und ist 
mit einer Vielzahl an Schnittstellen und Formaten kompatibel. Mit der X4 BPMS vermeiden Sie 
isolierte Informationssilos, produktivitätshemmende Medienbrüche und beschleunigen die 
Digitalisierung. 

Geschäftsprozesse ohne Programmieraufwand zu realisieren, ermöglicht einem großen 
Anwenderkreis den Einstieg in das Management von Geschäftsprozessen. Das lohnt sich, denn 
Mitarbeiter der Fachabteilung wissen in der Regel am besten, worauf es bei den jeweiligen 
Geschäftsabläufen im Kern ankommt. Setzen Sie daher auf die X4 BPMS als Plattform, deren 
Werkzeuge die Komplexität soweit reduzieren, dass sich auch ohne Programmierkenntnisse 
Geschäftsprozesse analysieren, optimieren, modellieren als auch kontrollieren und dokumentieren 
lassen. Alle Werkzeuge unterstützen eine integrierte, grafische Prozessmodellierung und 
-implementierung und erzeugen Prozesse, die von der X4 BPMS performant ausgeführt werden.

X4 Designer: Prozesse und Regeln grafisch modellieren
X4 Server: Simulation und Ausführung der Prozesse und Regeln
X4 Adapter: Drittsysteme in Prozesse integrieren
X4 Web Apps: Web Apps für Mitarbeiter und Kunden bereitstellen
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1 Oberfläche

1 Menüleiste Über die Menüleiste können Sie verschiedene Funktionen und 
Editoren des X4 Designers aufrufen.

2 Symbolleiste Über die Symbolleiste können Sie verschiedene Funktionen und 
Anzeigeoptionen aufrufen. Einige Symbole sind nur aktiv, wenn 
die entsprechende Funktion für das ausgewählte oder geöffnete 
Element verfügbar ist, siehe auch Symbolleiste.

3 Sichten Sie können die angezeigten Sichten per Drag&Drop individuell 
anordnen.

4 Perspektiven Über diese Symbole können Sie zwischen den Perspektiven X4 
Designer, Debug und BPMN Designer wechseln.

5 Editoren und 
Zeichnungsfläche

In diesem Bereich werden Prozesse und Dateien zum Anzeigen 
und Bearbeiten in Registerkarten geöffnet.

6 Statusleiste In der Statusleiste werden der verbundene Server, der 
angemeldete Benutzer und die Version der X4 BPMS angezeigt.
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1.1 Symbolleiste
Über die Symbolleiste können Sie verschiedene Funktionen und Anzeigeoptionen aufrufen. Einige 
Symbole sind nur aktiv, wenn die entsprechende Funktion für das ausgewählte oder geöffnete 
Element verfügbar ist.

Connect Verbindung zum Server herstellen

Disconnect Verbindung zum Server trennen

New Neues Element hinzufügen

 Welche Elemente Sie über dieses Symbol hinzufügen können, 
hängt davon ab, in welcher Perspektive und an welcher Stelle der 
Baumstruktur im Repository Sie sich befinden.

Save Änderungen im aktuell geöffneten Fenster speichern

Save all Alle Änderungen speichern

Repository Refresh Server-seitige Aktualisierung durchführen

/
Attach/Detach Debug Debugger mit der Server-Instanz verbinden/Debugger von der 

Server-Instanz lösen

Start Debugging Debugger starten

Undo Letzten Bearbeitungsschritt rückgängig machen

Redo Rückgängig gemachten Schritt wiederherstellen

Cut Auswahl ausschneiden

Copy Auswahl kopieren

Paste Auswahl einfügen

Start Debugging Optionen zur Prozessausführung aufrufen:

Start Debugging: Prozess debuggen (Fehler anzeigen 
und beseitigen)
Start Without Debugging: Prozess direkt ausführen
Debug/Run Options: Run/Debug-Einstellungen im X4 
Designer öffnen
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Suspend Debugging anhalten

Resume Debugging fortsetzen

Stop Debugging Debugging beenden

Step Into Prozess-Schritt ausführen (mit Anzeige der Schritte des 
Subprozesses)

Step Over Prozess-Schritt ausführen (ohne Anzeige der Schritte des 
Subprozesses)

Step Return Aus Subprozess herausspringen

Toggle Breakpoint Breakpoint (Debug-Haltepunkt) zu markiertem Baustein setzen 
oder entfernen

Clear all Breakpoints Alle Breakpoints in diesem Prozess löschen

Quick Watch Quick-Watch-Sicht öffnen, um Platzhalter, dynamische 
Parameter und Kontextvariablen mit ihren Werten während des 
Debuggens zu betrachten

Output Output-Sicht öffnen, um das Ergebnis jedes Prozess-Schrittes 
während des Debuggens zu betrachten

Zoom Out Ansicht verkleinern

Zoom Zoom-Stufe wählen

Zoom In Ansicht vergrößern

Snap to grid Raster einblenden und Bausteine am Raster ausrichten

Show Process Quality Index Process Quality Index einblenden

1.2 Kontextmenü
Kontextmenü für Prozessbausteine 
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Wenn Sie im Editor-Bereich des X4 Designers mit der rechten Maustaste auf einen Prozessbaustein 
klicken, stehen Ihnen je nach Bausteinart und Prozesstyp verschiedene Funktionen zur Verfügung:
Add Component Neue Prozesskomponente hinzufügen
Layout Ausgewählte Prozesskomponenten ausrichten:

Align Horizontal: Komponenten anhand des Mittelwertes 
horizontal ausrichten
Align Vertical: Komponenten anhand des Mittelwertes 
vertikal ausrichten
Distribute Horizontal: Komponenten gleichmäßig 
horizontal verteilen
Distribute Vertical: Komponenten gleichmäßig vertikal 
verteilen

Select All Alle Prozesskomponenten auswählen
Copy Process Diagram to 
Clipboard

Prozessdiagramm zwischenspeichern

Edit Label... Namen der Prozesskomponente bearbeiten
Undo ... Rückgängig machen

Redo ... Letzten Schritt wiederherstellen

Copy Markierten Prozessbaustein kopieren

Cut Markierten Prozessbaustein ausschneiden

Set ... document Markierten Baustein durch ein anderes Element im Repository 
austauschen

Edit ... Markierten Baustein/Datei bearbeiten (nur Modul-Bausteine und 
Dokumente)

Toggle Breakpoint Debug-Haltepunkt setzen

Delete Prozessbaustein aus dem Prozessdiagramm entfernen

Validate Subprozess auf Gültigkeit prüfen (nur bei Subprozessen)
Preview Prozessbaustein in separatem Editor öffnen (nur bei Modul-

Bausteinen und Dokumenten)
Show input schema Input-Schema des Subprozesses anzeigen (falls vorhanden)
Show output schema Output-Schema des Subprozesses anzeigen (falls vorhanden)
Select in Repository 
Navigator

Prozessbaustein im Repository Navigator zeigen

View Call Hierarchy Verwendungsnachweis für den markierten Prozessbaustein anzeigen

Refresh Prozessbaustein neu aus dem Repository laden (nur bei Modul-
Bausteinen und Dokumenten)
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Bring to Front Symbol in den Vordergrund des Diagramms setzen
Bring Forward Symbol im Diagramm eine Ebene nach vorne setzen

Send Backward Symbol im Diagramm eine Ebene nach hinten setzen

Send to Back Symbol in den Hintergrund des Diagramms setzen

Properties Eigenschaften des Prozessbausteins in der Properties-Sicht anzeigen

Schema Declaration... Schema-Deklaration für den Prozess hinterlegen

Kontextmenü in der Projects-Sicht

Das Kontextmenü können Sie per Rechtsklick auf ein Element in der Projects-Sicht aufrufen.

New Neue Elemente (Prozesse, Ordner, Adapter etc.) im Repository 
anlegen

Open / Open With Markiertes Element (Prozess, Ordner, Adapter etc.) mit dem 
Standard-Editor oder einem bestimmten Editor öffnen

Save As Template Markiertes Element als Vorlage speichern
Copy Full Path to Clipboard /
Copy XStore URL to 
Clipboard

Pfad zur markierten Datei in die Zwischenablage kopieren (als 
Ordnerpfad oder als xstore://-URL)

Cut, Copy und Paste Markiertes Elemente ausschneiden, kopieren oder einfügen
Delete Markiertes Element aus dem Repository löschen (der Löschvorgang 

kann nicht rückgängig gemacht werden)
Rename/Refactor Element (und falls gewünscht dessen Referenzen) umbenennen
Exclude from Project Ressource aus dem Projekt ausschließen

Include to Project Ausgeschlossene Ressource wieder in das Projekt aufnehmen
Repair References Pfade von Repository-Ressourcen in Prozessdiagrammen reparieren
Validate Prozess auf Gültigkeit prüfen
View Call Hierarchy Anzeigen, in welchen Prozessen dieses Element verwendet wird
Start Without Debugging Prozess direkt ausführen
Import Ressource ins Repository importieren
Export Projekt oder Ressource exportieren

•

•

Die Datei wird im Dateisystem beibehalten, ist jedoch 
nicht mehr Bestandteil des Projektes und wird ausgegraut 
dargestellt.
Die üblichen Operationen wie Öffnen, Bearbeiten, 
Kopieren, Löschen usw. können für ausgeschlossene 
Dateien nicht ausgeführt werden.





X4 Data Model

© SoftProject GmbH 10

•

1.
2.

Clean-Up Project Nicht verwendete Dateien auswählen und aus dem Repository 
löschen

1.3 Perspektiven
Eine Perspektive ist eine festgelegte Anordnung von Sichten und dem Editorbereich. Sie können per 
Drag&Drop individuell anordnen.

X4 Designer Die X4 Designer-Perspektive ist die Standardansicht.

Debug Die Debug-Perspektive ist eine optimierte Ansicht für das Debugging von 
Geschäftsprozessen und technischen Prozessen.

BPMN 
Designer

Die BPMN Designer-Perspektive ist eine optimierte Ansicht für die Modellierung von 
Geschäftsprozessen.

1.3.1 Perspektive wechseln
Im X4 Designer können Sie zwischen Perspektiven wechseln. Die Anordnung der Sichten bleibt dabei 
erhalten.

Um die Perspektive zu wechseln, klicken Sie im oberen rechten Bildschirmbereich auf das 
Symbol der gewünschten Perspektive.

1.3.2 Perspektive zurücksetzen
Um eine Perspektive zurückzusetzen, gehen Sie wie folgt vor:

Wechseln Sie in die Perspektive.
Wählen Sie in der Menüleiste Window > Reset Window Layout.
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1.4 Sichten
Projects In der Sicht Projects wird eine Baumstruktur des verbundenen Repositorys mit 

verschiedenen Elementen wie Projekten, Ordnern und Dateien angezeigt. Sie können 
das Kontextmenü aufrufen, indem Sie mit der rechten Maustaste auf ein Element 
klicken. Abhängig davon, an welcher Stelle in der Baumstruktur Sie sich befinden, 
ändern sich die Optionen im Kontextmenü.

Über das Textfeld Filter über dem Projektbaum können Sie nach Dateien innerhalb 
des verbundenen Repositorys suchen. Platzhalter wie * oder ? sind nicht möglich.

Über die Symbolleiste der Sicht Projects können Sie die folgenden Aktionen 
ausführen:

 Jump from active Editor to Repository Navigator: Geöffnete Datei im Editor 
im Repository Navigator markieren

 Show or hide all files: Inhalt des Dateisystems einblenden und ausblenden. 
Aus dem Projekt ausgeschlossene Dateien werden dabei ausgegraut dargestellt.

Apps In der Sicht Apps werden alle X4 Apps angezeigt, die zum Bündeln von Projekten 
verwendet werden.
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Properties In der Sicht Properties können Sie die Eigenschaften von markierten 
Prozessbausteinen und geöffneten Prozessen anzeigen und bearbeiten.

In der linken Spalte befinden sich die Eigenschaften, in der rechten Spalte die 
zugehörigen Werte.
Für jeden Prozess kann ein Titel sowie eine Beschreibung hinterlegt werden. 
Diese Angaben werden in der erzeugten Dokumentation angezeigt.
Um die Eigenschaften eines geöffneten Prozesses zu bearbeiten, klicken Sie auf 
einen leeren Bereich auf der Zeichnungsfläche.

Standardmäßig werden die gebräuchlichsten Eigenschaften angezeigt. Über die 
Symbolleiste der Sicht Properties können Sie jedoch zusätzliche Einstellungen 
vornehmen:

 Pin to Selection: Angezeigte Eigenschaften in der Sicht Properties anheften

 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen

 Show Advanced Properties: Erweiterte Eigenschaften anzeigen

 Restore Default Value: Auf Standardwerte zurücksetzen

View Menu: Zusatzoptionen öffnen
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Run/Debug 
Console

Wird ein Prozess auf Fehler überprüft bzw. simuliert, werden in der Sicht Run/Debug 
Console zu jedem ausgeführten Prozess-Schritt Debug-Informationen angezeigt. 
Fehlermeldungen werden rot hervorgehoben, erfolgreiche Statusmeldungen grün.

Wenn ein Prozess-Schritt ein Zwischenergebnis ausgibt, wird dieses während des 
Debuggens in einer temporären Datei gespeichert, die Sie über den entsprechenden 
Verweis ansehen können (z. B. file://1376054979039/). 

 Sie können die Sicht Run/Debug Console über das Menü View > Run/Debug 
Console aufrufen.

file://1376054979039/
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Output In der Sicht Output können Sie die Ergebnisse jedes einzelnen Debug-Schrittes 
einsehen.

Über die Symbolleiste können Sie außerdem die folgenden Aktionen ausführen:

Find content: Daten in der Sicht Output finden

Copy all content: Alle Daten in der Sicht Output in die Zwischenablage 
kopieren

Copy selected content: Ausgewählte Daten in der Sicht Output in die 
Zwischenablage kopieren

 Save content of output view: Daten aus der Sicht Output speichern
 Format the content of the output view: Daten aus der Sicht Output

formatieren

 Sie können die Sicht Output während des Debuggens über das Menü Debug > 
Output oder über das Output-Icon  in der Symbolleiste aufrufen.

Enthält das Ergebnis Inhalte, die größer als 1 MB sind, wird eine Warnung 
angezeigt, und Sie können das Ergebnis über eine Schaltfläche 
herunterladen.
Große Datenmengen können sich negativ auf die Leistungsfähigkeit des X4 
Designers auswirken. 


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X4 Server 
Log

In der Sicht X4 Server Log können Sie den Server-Status und insbesondere Fehler im 
X4-Server-Log aus dem X4 Designer heraus verfolgen.

 Sie können die Sicht X4 Server Log über das Menü View > X4 Server Log aufrufen.

Call 
Hierarchy

In der Sicht Call Hierarchy können Sie für jeden Prozess und Prozessbaustein im 
Repository anzeigen, von welchen Repository-Elementen diese verwendet werden.

Wenn Sie mit der rechten Maustaste auf ein Element im Repository Navigator 
klicken, wird ein Kontextmenü aufgerufen. Mit View Call Hierarchy wird 
anschließend eine Auflistung aller Repository-Elemente angezeigt, die mindestens 
eine Referenz auf das markierte Element enthalten.
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Error Log In der Sicht Error Log können Sie im X4 Designer aufgetretene Fehler einsehen.

Über die Symbolleiste können Sie außerdem die folgenden Aktionen ausführen:

 Export Log: Error Log exportieren und als .log-Datei speichern
 Import Log: Error Log (.log) importieren
 Clear Log Viewer: Error Log bereinigen 
 Delete Log: Error Log unwiderruflich löschen
 Open Log: Log-Datei (.log) im X4 Designer öffnen
 Restore Log: Error Log wiederherstellen
View Menu: Zusatzoptionen öffnen

 Sie können die Sicht Error Log über das Menü View > Error Log aufrufen.

Problems In der Sicht Problems werden alle Fehler und Warnungen aufgelistet. Sie können die 
Liste der Probleme über das Filtersymbol anpassen.

Debug 
sessions

In der Sicht Debug sessions werden alle aktiven Debug-Sessions aufgelistet. Indem 
Sie in der Sicht Debug sessions auf einen Prozess doppelklicken, wechseln Sie in die 
zugehörige Debug-Session.

Aktive Debug-Sessions sind grau markiert. Mit dem Server verbundene, neue Debug-
Sessions sind orange markiert.

Breakpoint
s

In der Sicht Breakpoints werden alle gesetzten Breakspoints aufgelistet. Sie können 
Breakpoints aktivieren, deaktivieren und löschen. Außerdem können Sie alle 
Breakpoints überspringen, ohne die Breakpoints zu löschen.
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Quick 
Watch

In der Sicht Quick Watch können Sie Platzhalter, dynamische Parameter und 
Kontextvariablen mit ihren Werten während des Debuggens betrachten.

Ausgewählte Variablen werden nach jedem Debug-Schritt aktualisiert.

 Sie können die Sicht Quick Watch während des Debuggens über das Menü Debug > 
Quick Watch oder über das Quick-Watch-Symbol  in der Symbolleiste aufrufen.

Outline In der Sicht Outline wird das vollständige Prozessdiagramm als Abbildung angezeigt. 
Sie können auf einzelne Bereiche in der Abbildung klicken und so mühelos durch den 
Prozess navigieren, selbst wenn die Abbildung größer ist als das Designer-Fenster.

 Sie können die Sicht Outline über das Menü View > Outline aufrufen.

Base64 Zeichenketten Base64-kodieren oder dekodieren

Digest Hash-Wert für Zeichenketten erzeugen

Regex Regulären Ausdruck (Regex) auf eine Zeichenkette anwenden, um den Ausdruck zu 
testen oder um die Zeichenkette gemäß einem Muster direkt zu ersetzen

URLCodec Zeichenketten URL-kodieren oder dekodieren

1.4.1 Sichten öffnen

Wählen Sie in der Menüleiste im Menü View die gewünschte Sicht.

Enthält das Ergebnis Inhalte, die größer als 1 MB sind, wird eine Warnung 
angezeigt, und Sie können das Ergebnis über eine Schaltfläche 
herunterladen.
Große Datenmengen können sich negativ auf die Leistungsfähigkeit des X4 
Designers auswirken. 



In der Perspektive BPMN Designer können keine weiteren Sichten geöffnet werden, da alle 
relevanten Sichten standardmäßig geöffnet sind.


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2 Mit Data Model Projects arbeiten
Mit dem Projekttyp Data Model Project können Sie komplexe Datenmodelle definieren und in ESB-
Prozesse und X4 Web Apps einbinden. In einem Data Model Project können Sie komplexe 
Datenstrukturen abbilden, wie zum Beispiel eine Bestellung mit Adressen und Positionen, die Sie an 
anderen Stellen wiederverwenden. Das bietet den großen Vorteil, dass Datenmodelle z. B. in X4 Web 
Apps wiederverwendet werden können und nicht mehrfach definiert werden müssen. 

2.1 Data Model Project anlegen
So legen Sie ein neues Data Model Project an:

Klicken Sie im X4 Designer in der Sicht Projects mit der rechten Maustaste, und wählen Sie im 
Kontextmenü den Eintrag New. 
Wählen Sie Data Model Project....

Geben Sie im Dialogfenster Project Creation Wizard einen Namen für Ihr Projekt ein.
Wählen Sie Finish.

Data Model Projects haben eine vordefinierte Ordnerstruktur, die beim Anlegen eines neuen Data 
Model Projects automatisch angelegt wird. 

Entities Dieser Ordner ist beim Anlegen eines Projekts leer. Sie können 1 bis n 
Entitäten hinzufügen.

<Projekt>.datamodel Projektbezogene Datei, die die Definition des Data Models enthält. 
Hier legen Sie die Beziehungen zwischen den Entitäten fest.

Beim Anlegen eines neuen Data Model Projects sieht die Datei <Projekt>.datamodel wie folgt aus:

<DataModel xmlns="http://softproject.de/datamodel/1.0">
    <EntityRelationships>
    </EntityRelationships>
</DataModel>

Alternativ können Sie im Menü File auf New klicken und Data Model Project...
auswählen.



Der automatisch angelegte Ordner Entities kann nicht 
gelöscht, verschoben oder umbenannt werden.


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Das Element EntityRelationships wird verwendet, um die Verknüpfungen zwischen den von Ihnen 
angelegten Entitäten festzulegen, die im Data Model dargestellt werden. Alle Verknüpfungen, die Sie 
festlegen, führen zu einer Hierarchie. Wie Sie Entitäten anlegen, erfahren Sie im Abschnitt Entitäten 
anlegen.

Das Element EntityRelationships kann folgende Elemente enthalten:

OneToOne
OneToMany
ManytoOne

Innerhalb dieser drei Elemente können die Verknüpfungen zwischen den Entitäten über folgende 
Attribute definiert werden:

Attribut Beschreibung
entity Mit diesem Attribut geben Sie die Ausgangsentität der Verknüpfung 

an.
toEntity Mit diesem Attribut geben Sie die Zielentität der Verknüpfung an.
property Mit diesem Attribut geben Sie den Namen an, unter dem die in 

toEntity angegebene Entität bei der weiteren Verwendung des Data 
Models für die entity referenziert wird.

Sie können z. B. für eine 1:1-Verknüpfung aus Kunde und Adresse als 
property eine Lieferadresse angeben, wie im folgenden Beispiel 
gezeigt. 

Beispiel:

<DataModel xmlns="http://softproject.de/datamodel/1.0">
    <EntityRelationships>
    <OneToOne entity="Customer.entity" toEntity="Address.entity" 
property="DeliveryAddress"/>
    <OneToMany entity="Customer.entity" toEntity="Order.entity" property="Order"/>
    <ManyToOne entity="Order.entity" toEntity="Customer.entity" property="Customer"/>
    </EntityRelationships>
</DataModel>

Zur Veranschaulichung finden Sie im Folgenden die Abbildung einer OneToOne-Verknüpfung im XML-
Format:
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<?xml version="1.0" encoding="UTF-8"?>
<Customer>
 <Name>Doe</Name>
 <Firstname>John</Firstname>
 <DeliveryAddress>
   <City>Exampletown</City>
   <Zip>1234</Zip>
   <Street>Mainstreet</Street>
 </DeliveryAddress>
</Customer>

2.2 Entitäten anlegen
Jede Entität entspricht einem Objekt in Ihrer Anwendung, wie z. B. „Bestellung“ oder „Kunde“. Die 
Beziehung zwischen zwei oder mehr Entitäten wird über Zuordnungen dargestellt. Jede Entität 
(Objekt) enthält Felder (Eigenschaften) und wird mit einem eindeutigen technischen ID-Feld versehen, 
das für Verknüpfungen benötigt wird.

So legen Sie eine neue Entität an:

Klicken Sie mit der rechten Maustaste auf den Ordner Entities.
Wählen Sie New > Entity.
Geben Sie im Dialogfenster File Creation Wizard einen Namen für die Entität ein. 
Wählen Sie Finish.

Im nächsten Schritt können Sie Eigenschaften zu Ihrer Entität hinzufügen. Dazu doppelklicken Sie in 
der Sicht Projects auf die .entity-Datei, um Sie im Entity Editor zu öffnen.

Wählen Sie Add, um die gewünschten Eigenschaften hinzuzufügen, wie z. B. name oder id:
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1.
2.

Die Tabelle in der .entity-Datei enthält folgende Felder:

Feld Beschreibung
Name Hier geben Sie den gewünschten Namen für die Eigenschaft ein.

Mit der Schaltfläche Add können Sie eine neue Eigenschaft 
hinzufügen.

Mit der Schaltfläche Remove können Sie Eigenschaften entfernen, die 
Sie nicht mehr benötigen.

Type Mit dieser Dropdown-Liste legen Sie den Typ der Eigenschaft fest.

Mögliche Werte:

STRING: Beliebige Zeichenkette
INTEGER: Ganzzahl
DECIMAL: Kommazahl
BOOLEAN: Boolescher Wert
DATE: Datumsangabe
DATETIME: Datums- und Zeitangabe

Is ID Mit diesem Kontrollkästchen legen Sie fest, ob die Eigenschaft eine 
definierte ID ist.

Mandatory Mit diesem Kontrollkästchen legen Sie fest, ob die Eigenschaft 
obligatorisch oder optional ist.

Read only Mit diesem Kontrollkästchen legen Sie fest, ob die Eigenschaft 
schreibgeschützt ist.

2.3 Data Model in einem ESB Project nutzen
So nutzen Sie ein Data Model in einem ESB Project:

Legen Sie ein neues ESB Project an, oder öffnen Sie ein vorhandenes ESB Project. 
Klicken Sie mit der rechten Maustaste auf den Ordner Transformations, und wählen Sie New > 
XSL Stylesheet.

Sie können die Einträge sortieren, indem Sie einen Eintrag markieren und mit den Pfeiltasten 
oben rechts nach oben oder nach unten verschieben. So können Sie alle Einträge wie 
gewünscht anordnen.



Neben der oben gezeigten Design-Ansicht können Sie die .entity-Datei auch in der 
Source-Ansicht öffnen und die Eigenschaften in Form von XML-Elementen und den 
zugehörigen Attributen definieren.


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3.

4.
5.

6.

7.

1.
2.

3.

Wählen Sie im Dialogfenster File Creation Wizard den Eintrag Empty, um eine leere 
Transformation anzulegen.
Geben Sie einen Namen für die Mapping-Datei ein, und klicken Sie auf Finish.
Ziehen Sie die .datamodel-Datei aus dem Data Model Project per Drag&Drop in den leeren 
Bereich auf der linken Seite.
Daraufhin wird das Dialogfenster Select Entities geöffnet. Hier wählen Sie die Entitäten aus 
Ihrem Data Model aus, die Sie in die Mapping-Datei übernehmen möchten. 

Für das im Abschnitt Data Model Project anlegen gezeigte Beispiel, in dem die Entitäten 
Customer, Address und Order mit verschiedenen Verknüpfungen angelegt wurden, ergeben 
sich folgende Auswahlmöglichkeiten:

Wenn die Struktur erzeugt wurde und abgebildet wird, können Sie mit dem Mapping beginnen. 
Weitere Informationen hierzu finden Sie unter Mapping.

2.4 Data Model in einer X4 Web App nutzen
So nutzen Sie ein Data Model in einer X4 Web App:

Legen Sie ein neues Web App Project an, oder öffnen Sie ein vorhandenes Web App Project.
Klicken Sie mit der rechten Maustaste auf den Ordner ViewModels, und wählen Sie New > View 
Model....
Geben Sie im Dialogfenster File Creation Wizard einen Namen für das View Model ein, und 
klicken Sie auf Finish.
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4.

5.

Ziehen Sie die .datamodel-Datei aus dem Data Model Project per Drag&Drop in das Element 
Properties in der .viewmodel-Datei.
Daraufhin wird das Dialogfenster Select Entities geöffnet. Hier wählen Sie die Entitäten aus 
Ihrem Data Model aus, die Sie in der .viewmodel-Datei referenzieren möchten.

In der .viewmodel-Datei werden die Entitäten mit ihren Eigenschaften referenziert. Sie können die 
Eigenschaften mit ergänzenden Eigenschaften (displayName, readOnly) bearbeiten.

Beispiel:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ViewModel xmlns="http://softproject.de/viewmodel/1.0">
    <Properties>
        <Model path="Demo/Entities/Customer.entity">
            <ModelProperty name="Name" displayName="Name" readOnly="false"/>
            <ModelProperty name="Firstname" readOnly="false"/>
            <ModelObject name="DeliveryAddress" path="Demo/Entities/Address.entity">
                <ModelProperty name="City" readOnly="false"/>
                <ModelProperty name="Zip" readOnly="false"/>
                <ModelProperty name="Street" readOnly="false"/>
            </ModelObject>
            <ModelList name="Order" path="Demo/Entities/Order.entity">
                <ModelProperty name="Product" readOnly="false"/>
                <ModelProperty name="Quantity" readOnly="false"/>
                <ModelObject name="Customer" path="Demo/Entities/Customer.entity">
                    <ModelProperty name="Name" readOnly="false"/>
                    <ModelProperty name="Firstname" readOnly="false"/>
                    <ModelObject name="DeliveryAddress" path="Demo/Entities/
Address.entity">
                        <ModelProperty name="City" readOnly="false"/>
                        <ModelProperty name="Zip" readOnly="false"/>
                        <ModelProperty name="Street" readOnly="false"/>
                    </ModelObject>
                </ModelObject>
            </ModelList>
        </Model>
    </Properties>
</ViewModel>

Beispiel für die Einbindung einer .viewmodel-Datei in eine Component:
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<?xml version="1.0" encoding="UTF-8"?>
<DetailComponent xmlns="http://softproject.de/webapp/1.0" 
viewmodel="ViewModel.viewmodel">
<Properties>
</Properties>
<FlowLayout>
<Header value="Welcome to my new Web App!" />
<TextBox value="#Customer.Name" />
</FlowLayout>
</DetailComponent>
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